Colour Management
Consistently reproduce colour in your photography.

Inits simplest form, colour management is the process of balancing your monitor to achieve
colour consistency between your display and final print output. The end goal is to have imag-

es displayed on your screen more closely match the final printed product.

Follow the steps in the steps below to achieve more consistent results across your screen and

final print output.
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Step 1 - Monitor Calibration

The first step towards achieving colour consistency between your screen and final prints is us-

ing a monitor calibration device, such as X-Rite’s ColorMunki Display, to calibrate your screen.

Calibration devices attach to the front of your monitor and analyse a series of colours and grey

levels displayed on your screen via the device's software.

Often the most prominent issue seen in uncalibrated screens is the brightness being set too
high under default factory settings, meaning that the final print output appears to significantly
darker in comparison. One of the primary goals of a calibration device is to set a more appro-

priate screen brightness.

More advanced devices also measure your room’s ambient light levels to adjust the bright-
ness, further helping to avoid prints which appear too dark when compared side-by-side in

the same lighting environment and conditions.

Using the readings taken during the calibration process, the calibration software creates a
colour profile which instructs your screen to render each colour in a way that will match the

print output.

N.B. Although all monitors can be calibrated to at least a basic level the accuracy of the results
will vary depending on the quality of your screen. A low-quality, budget monitor which has
been calibrated will still provide sub-par results. Common recommendations for colour criti-
cal work include Eizo, NEC and Dell’s UltraSharp models. At Loxley Colour we use Eizo CG246

displays. It is important to note that even the best screens will still need to be calibrated.

Detailed monitor reviews and recommendations can be found at TFT Central.
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Step 2 - File Format & Colour Space

It is essential to ensure your images are in the appropriate format before placing and order

with Loxley Colour. All images should be high-quality 8-bit JPEGs in either the sRGB, Adobe

RGB or ProPhoto RGB colour spaces.

Lightroom Export Setting

We would recommend creating and saving an Export Preset using the following settings for

future print use.

0086 Export One File
Export To: | Hard Drive =
Preset Export One File

¥ Lightroom Presets b Export Location s et loe
Burn Full-Sized JPEGs
Export ta DNG Biifils Naming 4505-042-Edit 2pg
For Email » Video
For Email (Hard Drive) = =

» DxO Labs ¥ File Settings

b Coogle Image Format [ JPEG

W User Presets

aill gl St e LA

Export original Color Space: | sRGB +] [ Limit File Size To: 100 K
Full-sized JPEG
| ¥ Image Sizing
[[] Resize to Fit: | Width & Height 4| [ Don't Enlarge

w1024 H: |1024

| pixels *| Resolution: 300

| pixels perinch  * |

|_Y QOutput Sharpening

gshc rpen For: Il;rlnt -

) Amount: | Standard

b Metadata

Copyright & Contact Info Only

Add | Remove | | ¥ watermarking

| Plug-in Manager... |

Recommended Settings:

Image Format: Loxley Colour accept JPEG files only
Colour Space: sRGB / Adobe RGB / Pro Photo RGB

Quality:"100"to preserve full image quality

Conca |

Resize to Fit: Ensure this is unchecked to preserve maximum quality

Don't Enlarge: Ensure this is unchecked to preserve maximum quality

Sharpen For: Print
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Photoshop Export Setting

We would recommend creating and saving an Export Preset using the following settings for

future print use.

New
Name: |Untitled-5 | | oK |
Document Type: | Custom ¢
Widih: |20 | Inches :] Delete Preset...
Height: |16 | [Inches :]
Resolution: [300 || Pixels/Inch ]
|

Color Mode: | RGB Color | [ 8 bit

a

Background Contents: | White

Advanced

Color Profile: l sRGB IEC61966-2.1

A

Pixel Aspect Ratio: | Square Pixels

b

Image Size:
82.4M

Color Settings

Settings: | Custom

Working Spaces

Conversion Options

RGB: \.ERGE |IEC61966-2.1

Engine: | Adobe (ACE)

CMYK: | U.S. Web Coated (SWOP) v2

Intent: | Relative Colorimetric #|

Gray: | Dot Gain 20%

Spot: | Dot Gain 20%

Color Management Policies

RGB: | Preserve Embedded Profiles *
CMYK: | Preserve Embedded Profiles *
Gray: | Preserve Embedded Profiles *

Profile Mismatches: (Y] Ask When Opening (] Ask When Pasting
Missing Profiles: (] Ask When Opening

Description

[ Use Black Point Compensation
[]Use Dither (8-bit/channel images)

[ Compensate for Scene-referred Profiles

Advanced Controls

[ Desaturate Monitor Golors By: %
[ Blend RGB Colors Using Gamma:
[/ Blend Text Golors Using Gamma:

Unsynchronized: Your Creative Cloud

& e [ et

color.

We would recommend creating documents using the following settings for future print use.

Image Resolution: 300 Pixels/Inch (150 minimum)

Color Mode: RGB Color / 8 bit
Color Profile: sSRGB IEC61966-2.1

We would recommend the following colour settings within Photoshop (Edit > Colour Set-

tings..).

Working Spaces: RGB: sRGB IEC61966-2.1

Color Management Policies: RGB: Preserve Embedded Profiles

Profile Mismatches: Ensure Ask When Opening and Ask When Pasting are both checked.

Cancel

Save...

[ Preview
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Step 3 - Order Test Prints

An essential part of the overall colour management process at this stage is gauging how near/
far your monitor is to our print outputs, and to help with this we offer a free test print service.
For best results, submit a test print order containing a range of images which cover a wide
spectrum of colours. We also recommend you include a B&W image, as these can help with

any density adjustments you may need to make.

Important: When ordering, make sure to select ‘No Colour Correction’ Failure to do so will
mean your images will be printed from a version of your file which has been altered for best
results by our Colour Correction team, which will make any print to screen comparison inaccu-

rate.
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Step 4 - Soft Proofing

When you receive your test prints the next step is to compare the print results with what you see on

your screen.

At this stage there’s a good chance that, although your test prints will be a much closer match than
pre-calibration results, they won't exactly match the same images on your monitor just yet. By the

nature of their mediums, there are key differences between screen and print, including:

Monitors are luminous (have their own light source and emit light) whereas prints are reflective
Viewing conditions in conjunction with above: natural daylight has very different light temperature
from most artificial light sources and differences here can affect the overall look of your print

Paper colour/whiteness of the paper used can vary from print process to print process

Gamut of print process — the ability of the print process used to represent different colours

To help overcome this, programs such as Photoshop and Lightroom use a process called soft

proofing, which use print profiles to match the screen to the paper type.

Our soft-proofing profiles are designed to simulate the effects of the different types of print pro-
cess on offer at Loxley Colour. Soft proofing displays the files based on the printer colour space in
conjunction with the monitor profile. If done correctly, the image file itself is not altered, the pixel
values of the image remain untouched. The pixels displayed on the monitor are mapped so the

colours of the image are as close as possible to what a final print would look like.
We have a range of profiles for you to download, from Fuji photographic lustre paper to
Hahnemuhle fine art. Each profile will have a slightly different screen output as it tries to mimic the

process on offer.

It's important that the profile is used for proofing only and not saved to your files.
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More on installing and using soft proof profiles
Your test prints are printed on Fuji photographic lustre paper and should be compared to the
same image file on screen using the profile ‘Loxley Colour Photographic Lustre&Gloss'available

via our Print Profile Download page.

Profiles should be installed in the following location:

Windows PC - CAWindows\System32\Spool\Drivers\Color\

Mac - Macintosh HD > Library > Colorsync > Profiles

If you find a monitor-print match then you should be able to order prints knowing that the
output will be very close to your monitor, assuming you do not choose to use our Colour Cor-
rection service (includes brightness adjustments). As monitors very gradually dim over time, it
is advisable to keep the prints & associated files safe and check periodically that your monitor

hasn't shifted over time.

When different papers and print processes are used, such as Giclée Fine Art printing, make

sure to utilise the appropriate profile when soft-proofing.
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Soft Proofing in Lightroom

Lightroom cannot use CMYK profiles or colour spaces

Steps for soft proofing in Lightroom:
- Go into the Develop module
- Check'Soft Proofing’in the bottom tool bar

. Select ‘Before: Current State’in the bottom tool bar

| Before : Current State v Soft Frggﬁng

_DSC1933.NEF

[ e [

In the right hand menu you will now see the Soft Proofing dialogue

- Select'Show destination gamut warning'- reds show
areas printer can't handle

- Click'Create Proof Copy’

- To load the Loxley Colour print profile in Profile drop
down >'Other../> and then locate the profile on your
system

s FraoT Coy - Choose 'Perceptual’as Intent

«'Simulate Paper and Ink’should be unchecked

Adjust levels of your Soft Proof version to match your
sRGE

original
AdobeRGE (1998)

LoxleyFujiDP2

Other... Video link for more information

(https://www.youtube.com/watch?v=1G83FrjUEyQ)

Color
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Soft Proofing in Photoshop

It's important that the profile is used for proofing only and not saved to your files.

A good technique to Soft Proof within Photoshop, is to take your chosen finalized image and
duplicate. This duplicated image can then be tweaked with your chosen ink and paper set-
tings, allowing you to keep your original file intact, and you can compare side by side to bring

your duplicated image close to the original.

- Image > Duplicate

« Window > Arrange > 2-up Vertical

To soft proof:

- View > Proof Setup > Custom...

- Device to Simulate: Your downloaded Loxley profile

- Rendering Intent: Perceptual

« Black Point Compensation should be checked

- Display Options (On-Screen): Simulate Paper Color should be unchecked
- Click OK

*screenshots on the following page
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Soft Proofing in Photoshop

(U8 Window Help

Proof Setup

Proof Colors ®Y
Gamut Warning {+38Y v Working CMYK

Pixel Aspect Ratio » Working Cyan Plate
Pixel Aspect Ratio Correction Working Magenta Plate
32-bit Preview Options... Working Yellow Plate
Working Black Plate

Zoom In £+ Working CMY Plates
Zoom Qut -

Fit on Screen ®0 Legacy Macintosh RGB (Gamma 1.8)
Fit Artboard on Screen Internet Standard RGB (sRGB)

100% #1 Monitor RGB

200%

Print Size Color Blindness - Protanopia-type

Color Blindness - Deuteranopia-type

Screen Mode

Extras

Customize Proof Condition

Custom Proof Condition: | Custom =|
Proof Conditions
Device to Simulate: | Your colour profile goes here ¢‘
Preserve Numbers
3 i Save
Rendering Intent: [ Perceptual -‘
[¥] Black Point Compensation [] Preview

Display Options {On-Screen)
[T] simulate Paper Color
[] simulate Black Ink

Now comparing your images side by side, you should be able to observe any differences on your
soft proof image. You can then make small changes to Levels and Curves, to bring your image as

close as possible to the original, before saving for print.

Photo Filter..
Channel Mixer...
‘Color Lookup...

Invert

Video link for more information

http.//www.photoshop.com/tutorials/4132
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